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1 Spreadspeed Help Introduction

Spreadspeed is a set of utilities and auditing tools for Microsoft Excel. The Spreadspeed help

file covers all its major functionalities, with the table of content organized to match the layout

of the Spreadspeed ribbon tab controls.

Spreadspeed Ribbon Tab in Excel

Ribbon Menu Icons

Instead of trying to encapsulate the functionality of each feature in an icon, the Spreadspeed

icons in the dropdown menus indicate what the icons operate on, as shown below.

Icon Indicates

A dialog (form) opens, allowing you to select a range if applicable.

The feature is run from a task pane (side panel).

The feature applies to the whole workbook.

The feature applies to the current worksheet.

The feature applies to the selected range.

The feature applies to tables (or applicable ranges).
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2 Range Selector

Spreadspeed uses the custom range selector shown in the image below.

Features

· Range selector: When you select a range with your mouse, the range address is shown in

the text box. You can choose a range on the current sheet, another worksheet, or another

workbook.

· Close button  : The close icon will return the selected range.

· Table / worksheet button  : If the selected cell is within a Table, the range containing the

table is returned, otherwise, the Used Range of the worksheet is returned.



Navigation Tools 9

© 2018 BreezeTree Software, LLC

3 Navigation Tools

3.1 Xplorer

The Xplorer tool lets you easily navigate to different sheets and objects within open

workbooks.

Form Fields

· Select workbook: Select a workbook from the list to view its contents.

· Select sheet or sheet item: This field will list all the sheets, charts, tables, and named

ranges. You can double-click an entry to navigate to it, or you can scroll through the items,

and then click the Go to selected item button.

· Address: Will list the range address of the selected item. If the item is a chart on a sheet,

the range at the top left corner of the chart is displayed in this field. If the item is a named

range that refers to an invalid range, then the address text is shown in red. (For example,

this can happen with a workbook level Named Range that refers to a range on a sheet that

has been deleted.)

· Refresh: Refreshes the content of the Xplorer pane. A manual refresh is required if you

open or close workbooks, add or delete sheets, named ranges, tables, or charts.

Unnavigable Items

If an item is hidden, or on a worksheet that is hidden, the Xplorer cannot navigate to it. 

Likewise, if a Named Range refers to an invalid address, then it cannot be navigated to.

3.2 Favorites

The Favorites tool lets you save and load favorite Excel objects and formulas.

Display

Favorites loads as a task pane (side panel) and displays two tabbed groups - Excel Objects

and Formulas. If you are running Excel 2013 or 2016, please note that the side panel only

displays in the workbook that you initially opened the favorites tool in.

Adding Favorite Excel Objects

You can save a workbook, worksheet, range or table to Favorites by clicking the Favorites
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dropdown on the Spreadspeed ribbon tab and selecting "Add selection to favorites" from the

menu. You can also a favorite Excel Object via the favorites task pane. When you are

prompted to add the favorite, you can specify which group the favorite belongs to.

Adding Favorite Formulas

If you have a custom formula that you reuse often, you can save it to Favorites by clicking the

Favorites dropdown on the Spreadspeed ribbon tab and selecting "Add formula to favorites"

from the menu. You can also add a formula and its description via the favorites task pane.

The formulas are stored in [R][C], a row - column relative format that makes the formulas

more portable.

Excel Objects

This tab lists the bookmarked favorites by group. You can open a favorite by double-clicking

the bookmarked item in the or by selecting it and clicking the "Load" button on the Favorites

task pane.

Formulas

This tab displays the list of saved formulas. To add a formulas to your worksheet, select the

cell where the formula is to be place and click the Insert button on the task pane.

3.3 File Operations

Spreadspeed provides three file operations tools:

· Open Files: An open file dialog that shows only Excel files (no .htm, or .xml) and separates

each file type into separate filters.

· Close All: Closes all open files in a single click and exits the application.

· Close All but Current: Closes all the open workbooks except the current (active) workbook.

Notes

· You will be prompted to save any unsaved work after clicking either of the Close buttons.

· Tip: Add these to the Excel Quick Access Toolbar to get the most use out of them.
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3.4 Quick Navigation Buttons

Spreadspeed provides three quick navigation tools:

· Home: Jumps to cell A1.

· New row: Jumps to the next cell in column A after the current used range.

· New column: Jumps to the next cell in row 1 after the current used range.

Tip: You can add these to the Excel Quick Access Toolbar.
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4 Workbook Tools

4.1 Create Table of Contents

The Create Table of Contents tool allows you to quickly create add a worksheet that lists all

the sheets in the current workbook. Plus you can optionally include - and link to - charts,

named ranges, and tables as well.

4.2 Sort Sheet Tabs

The Sort Sheet Tabs form allows you to sort the sheets in a workbook by name, sheet tab

color, or manually rearranging the order. In addition to sorting, you can double-click the sheet

name in the listing to edit and rename sheet tabs.

4.3 Add Multiple Worksheets

The Add Multiple Worksheets tool lets you add one or more sheets to the current workbook.

Form Fields

· Import names: Clicking the button will prompt for the range to import the names. If any of

the cells have a back fill color, the color will automatically be assigned as the sheet tab

color.

· Enter sheet names: You can type in new sheet names, one per line, and then click the add

button.

· New Worksheets: This listing shows the new sheet names and tab colors. You can double-

click the sheet name to edit it. Any rows with blank sheets names will not be added to the

workbook.

· Change tab color: Opens a dialog to select a new tab color for the selected row(s).

4.4 Remove Empty Worksheets

The Remove Empty Worksheets tool prompts you will a dialog showing all the empty sheets

in the workbook. You can uncheck any empty sheet that you don't want removed. If every

sheet in the workbook is empty and you attempt to remove them all, the first sheet will be

preserved since you cannot have a workbook without worksheets.
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4.5 Quick Hide / Unhide Sheets

The Quick Hide / Unhide Sheets tool lists all the sheets in the workbook. Checking the sheet

will hide it, and unchecking will unhide it. 

Notes

· There must be at least one visible sheet in the workbook.

· Very Hidden sheets are labeled as "(very hidden)". This tool will unhide Very Hidden sheets,

but you cannot use this tool to set a sheet as Very Hidden.

4.6 Save Worksheets to Separate Files

The Save Worksheets to Separate Files tool will take each worksheet, move it to a separate

file and save it under its own workbook.

Form Fields

· Worksheet listing grid: Includes a checkbox for indicating whether to extract each

worksheet, the sheet name, and the output file name (double-click the name to edit it).

· Save to folder: Allows you to specify where to save the extracted sheets.

· Remove saved workbooks: Indicates whether to make a copy of the extracted sheets or to

fully remove them from the current workbook.

Note: If you choose to remove the sheets from the current workbook, there must be at least

one sheet remaining in the workbook. Spreadspeed will default to retaining the first sheet.

4.7 Close and Re-Open Last Save

Spreadspeed operations that alter the content or formatting of the workbook will have a "Save

workbook ..." option on the dialog. Add-ins do not have access to the built-in undo / redo

operations of Excel, so the save option is included to ensure that you can revert back to the

previous state of the workbook using Close and Re-Open Last Save. The Close and Re-

Open Last Save tool will close the workbook without saving and then open it again.

4.8 Save a Backup Copy of Workbook

Saves a backup copy of the workbook to the same folder where the workbook is located. A

timestamp is added to the end of the file name in the form yyyy-MM-dd-HHmmss, where:
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· yyyy = 4-digit year.

· MM = month (01-12).

· dd = day (01-31).

· HH = hour (00-23)

· mm = minute (00-59)

· ss = seconds (00-59)

After saving, a message box will confirm the file save and display the time stamped file name.

4.9 Quick Protect

Quick Protect allows you to protect all the worksheets in a workbook in a single pass.

Form Fields

· Password: Optional password to secure the sheet protection. (Note: Spreadspeed does not

save the password. It uses the built-in password protection mechanism provided by Excel.)

· Hide password characters: Determines whether the password characters are displayed as

you type them.

· Apply to: All worksheets plus workbook structure [1] or just the active worksheet.

· Unlock cells with these styles: After protection, check cell types can be edited, and all other

cells are locked. These feature leverages built-in and custom styles to determine whether

cells are unlocked.

[1] Workbook structure affects the order of the sheet tabs, sheet names, and whether sheets

can be added, deleted, or hidden and unhidden.

4.10 Quick Unprotect

Quick Unprotect is the accompanying feature to Quick Protect.

Form Fields

· Password: If a password was used with Quick Protect, the same password is required

when unprotecting the workbook. (Note: Spreadspeed does not save the password. It uses

the built-in password protection mechanism provided by Excel.)

· Hide password characters: Determines whether the password characters are displayed as
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you type them.

· Apply to: All worksheets plus workbook structure [1] or just the active worksheet.

[1] Workbook structure affects the order of the sheet tabs, sheet names, and whether sheets

can be added, deleted, or hidden and unhidden.

4.11 Hide / Unhide Named Ranges

The Hide / Unhide Named Ranges tools lists all the named ranges in a workbook and lets you

set whether they are visible or not. To use, simply check the Visible checkbox in the Names

list to set the visibility.
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5 Worksheet Tools

5.1 Delete Blank Rows

Spreadspeed offers two  options for deleting blank rows:

Delete Blank Rows in Worksheet 

· Deletes all empty rows in the used range of the worksheet.

Delete Blank Rows in Selected Range:

· Deletes empty rows within the selection and shifts the cells up without affecting any rows

or columns outside of the selected area. 

· To use this option, you must first select the range of cells containing the blank rows.

5.2 Delete Blank Columns

Spreadspeed offers two  options for deleting blank columns:

Delete Blank Columns in Worksheet 

· Deletes all empty columns in the used range of the worksheet.

Delete Blank Columns in Selected Range:

· Deletes empty columns within the selection and shifts the cells left without affecting any

rows or columns outside of the selected area. 

· To use this option, you must first select the range of cells containing the blank columns.

5.3 Autofit Rows and Columns

The Autofit Rows and Columns tool gives several options for resizing the column widths and

row heights via the dialog.

Form Fields

· Autofit all: Performs the standard autofit along with the option to reset the blank columns

and/or rows to the standard width and height.

· Make widths / heights uniform: This option first autosizes the columns and/or rows, and

then it finds the max size and does a second pass setting each column or row to the max
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size.

· Resize to a fixed width / height: Allows you to set the fixed width / height for all columns

and/or rows.

5.4 Reset Used Range

The used range of a worksheet is the area that has ever had any content entered or format

applied. If you delete the content in the last row or column, the used range does not reset

automatically. This tool performs the reset, and then selects the last cell in the used range as

an indicator of the new boundary.
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6 Range Tools

6.1 Split Single Column into Multiple Columns

Split Single Column into Multiple Columns will split a single column into an array based on a

set of criteria.

Form Fields

· Input range: Allows you to set the column to split. The range must be a single column.

· Output location: The first cell where the results will be output.

· Split every X cells: Splits the column at regular intervals based on X.

· Split by criteria:

· On cell / after cell: If on cell is selected, then the cell matching the criteria is placed in

the first row of the next column. If after cell is selected, the cell matching is the last cell

of the current column and the split occurs on the next cell.

· Data type: Split on cells containing text, numbers, dates, or blank cells.

· Number value: Splits on cells containing numbers <, <=, = , >=, or > than the matching

number.

· Text match: the text match can be on the entire cell content or it can partial match

based on wildcards or a regular expression. case sensitivity is optional.

· Save workbook: See Close and Re-Open Workbook for details.

6.2 Split Single Row into Multiple  Rows

Split Single Row into Multiple Rows will split a single row into an array based on a set of

criteria.

Form Fields

· Input range: Allows you to set the row to split. The range must be a single row.

· Output location: The first cell where the results will be output.

· Split every X cells: Splits the column at regular intervals based on X.

· Split by criteria:

· On cell / after cell: If on cell is selected, then the cell matching the criteria is placed in

the first row of the next column. If after cell is selected, the cell matching is the last cell

of the current column and the split occurs on the next cell.
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· Data type: Split on cells containing text, numbers, dates, or blank cells.

· Number value: Splits on cells containing numbers <, <=, = , >=, or > than the matching

number.

· Text match: the text match can be on the entire cell content or it can partial match

based on wildcards or a regular expression. case sensitivity is optional.

· Save workbook: See Close and Re-Open Workbook for details.

6.3 Concatenate Columns

Concatenate Columns is a column merging tool with a few added options.

Form Fields

· Input range: Allows you to set the range to concatenate (it will initially contain the range

selected prior to opening the form). Each row in the selected range is concatenated

separately.

· Output range: The first cell where the column of results will be output.

· Delimiter: Optional character(s) that will be placed between cell content.

· Enclose content in quotes: If checked, the content of each cell will be quoted. This is useful

if concatenating with a comma delimiter and any of the cell content contains commas.

· Reverse concatenation order: If checked, the range will be joined from right to left. For

example, if the input range is A1:C1, then the concatenation will be C1 + B1 + A1 instead of

A1 + B1 + C1.

· Trim text before joining: Trims any excess spaces from the from or end of the cell content

before concatenating them.

· Save workbook: See Close and Re-Open Workbook for details.

Warning

Merging numeric cells without a delimiter will create a numeric output, not a textual

combination of the values.

6.4 Concatenate Rows

Concatenate Rows is a row merging tool with a few added options.

Form Fields
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· Input range: Allows you to set the range to concatenate (it will initially contain the range

selected prior to opening the form). Each column in the selected range is concatenated

separately.

· Output range: The first cell where the row of results will be output.

· Delimiter: Optional characters that will be placed between cell content.

· Enclose content in quotes: If checked, the content of each cell will be quoted. This is useful

if concatenating with a comma delimiter and any of the cell content contains commas.

· Reverse concatenation order: If checked, the range will be joined from bottom to top. For

example, if the input range is A1:A3, then the concatenation will be A3 + A2 + A1 instead of

A1 + A2 + A3.

· Trim text before joining: Trims any excess spaces from the from or end of the cell content

before concatenating them.

· Save workbook before processing: See Close and Re-Open Workbook for details.

Warning

Merging numeric cells without a delimiter will create a numeric output, not a textual

combination of the values.

6.5 Transpose in Place

The Transpose in Place tool allows you to transpose a selection in place without resorting to

Copy and Paste Special with the Transpose option, and then having to delete the original

content.

Notes

· For non-square ranges (different number of rows and columns), this will overwrite any

content in cells the fall within the resulting output range.

· This tool autosaves the workbook prior to the transpose operation. If you want to revert

back to the previous state, use the Close and Re-Open Workbook tool.

6.6 Swap Ranges

As the name indicates, the Swap Ranges tool swap the contents of two ranges.
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Form Fields

· Range 1: The first range to swap. Initially contains the range selected when the form is

opened.

· Range 2: The second range to swap.

· Swap: You can set it whether to swap only the values and number formats or to include the

cell formatting as well.

· Save workbook: See Close and Re-Open Workbook for details.

Notes

· Range 1 and Range 2 must be the same size (number of rows and columns).

· Range 1 and Range 2 cannot overlap.
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7 Table Tools

7.1 Filtering Records

A quick note on filtering records:

One of the objectives of Spreadspeed is to enhance Excel without trying to replicate built-in

functionality unless it can be improved upon. The row filtering that exists with Excel tables is

already excellent. So instead of trying to add filtering (aka, query criteria) to the table

operations, with Spreadspeed we recommend that you either filter the data before running the

table tools, or filter it after the fact and use the Extract Filtered Data tool to get the final data

set.

7.2 Join Tables

The Join Tables tool lets you combine the columns from two tables (worksheet ranges) to

create a new table.

Form Fields

· Join Type:

· Matching rows: Known as an SQL inner join, this option outputs only rows where there

is a match between columns.

· All table 1 items: Known as an SQL left outer join, this option outputs all of the table 1

fields and only the table 2 fields where the columns match.

· All table 2 items: Known as an SQL right outer join, this option outputs all of the table 2

fields and only the table 1 fields where the columns match.

· Table 1: Select the workbook, worksheet, and range where Table 1 is located. The "tables"

do not have to be Excel tables - any range will work.

· Table 2: Select the workbook, worksheet, and range where Table 1 is located.

· Select Matching Columns: In the second step of the Join Tables dialog, you select the

columns to match on between table 1 and table 2.

· Ignore case for text matching: If checked, the text casing is ignored when comparing the

fields in matching columns.

· Select Output Columns: Select the columns that you want included in the output table.

· Output To: You can output to a new worksheet (in the same workbook as Table 1) or to a
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new workbook.

· Worksheet name: Optional field to name the output worksheet.

7.3 Merge Tables

The Merge Tables tool lets you update one table from another. New rows in the update

source table can be appended to the end of the main table.

Form Fields

Table Selection Step

· Table 1: Select the workbook, worksheet, and range where Table 1 is located. The "tables"

do not have to be Excel tables - any range will work.

· Table 2: Select the workbook, worksheet, and range where Table 1 is located.

Matching Columns Step

· Select Matching Columns: In the second step of the Join Tables dialog, you select the

columns to match on between table 1 and table 2.

· Ignore case for matching columns: If checked, the text casing is ignored when comparing

the fields in matching columns.

Set Options Step

Merge Options - you must select at least one of these options to run Merge Tables:

· Merge Table 2 into Table 1: Updates Table 1 with values, formulas and number formats

from Table 2.

· Append new Table 2 rows to Table 1: Adds new rows from table 2 onto the end of  table 1.

· Mark Table 1 rows unmatched in Table 2: If table 1 has rows that don't exist in Table 2,

these can be marked with a selected fill color.

Note on fill colors: If you do not want the updated cells highlighted with a fill color, set the fill to

white.

Comparison Options
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· Skip Table 1 cells with formulas: This ensures that existing formulas do not get overwritten.

· Ignore text case when comparing strings: If checked, string capitalization is ignore when

checking for updates.

· Ignore blank cells in Table 2: Ensures that checks with content do not get overwritten with

blanks.

· Compare number and date formats: If checked, table 1 will be updated with changes to

table 2 number and date formatting.

Reporting Options:

· Add a Change Notes column: Adds a column to table 1 describing each row's updates.

Backup

Save time-stamped backup: saves a backup of the Table 1 workbook before applying the

updates.

7.4 Find Unmatched Rows

The Find Unmatched Rows tool compares the rows from two tables (worksheet ranges) and

create a new table listing all the rows that exist in one table but not the other.

Form Fields

· Join Type:

· Table 1 items not found in Table 2: This option outputs all of the Table 1 rows with no

matches in Table 2.

· Table 2 items not found in Table 1: This option outputs all of the Table 2 rows with no

matches in Table 1.

· Table 1: Select the workbook, worksheet, and range where Table 1 is located. The "tables"

do not have to be Excel tables - any range will work.

· Table 2: Select the workbook, worksheet, and range where Table 1 is located.

· Select Matching Columns: In the second step of the dialog, you select the columns to

match on between Table 1 and Table 2.
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· Ignore case for text matching: If checked, the text casing is ignored when comparing the

fields in matching columns.

· Select Output Columns: Select the columns that you want included in the output table.

· Output To: You can output to a new worksheet (in the same workbook as Table 1) or to a

new workbook.

· Worksheet name: Optional field to name the output worksheet.

7.5 Extract Columns

The Extract Columns tool will take the selected columns from a table (or worksheet range)

and output them to a new worksheet. This is a faster alternative to copying an entire

worksheet and deleting the unwanted columns.

Form Fields

· Select Source Table: Select the workbook, worksheet, and range where data is located.

The table does not have to be an Excel table - any range will work.

· Select Columns to Extract: Select the columns that you want included in the output table.

At least one column must be selected.

· Output To: You can output to a new worksheet or to a new workbook.

· Convert extracted formulas to values: Check this option if any formulas in the extracted

columns refer to cells that are not extracted.

· Worksheet name: Optional field to name the output worksheet.

7.6 Extract Filtered Data

The Extract Filtered Rows tool will take the selected columns from a table (or worksheet

range) and output them to a new worksheet. It is designed to be used in conjunction with

Excel's built-in row filtering tools available when you use Format as Table in Excel. The

Extract Filtered data will only extract the visible rows and selected columns to a new

worksheet or workbook.

Form Fields

· Select Source Table: Select the workbook, worksheet, and range where the data is located.

The table does not have to be an Excel table - any range will work.

· Select Columns to Extract: Select the columns that you want included in the output table.

At least one column must be selected.
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· Output To: You can output to a new worksheet or to a new workbook.

· Worksheet name: Optional field to name the output worksheet.

7.7 Extract Duplicate Data

Excel has a built-in tool to delete duplicate rows, but there are times when you want to identify

duplicates instead of deleting them. The Extract Duplicates will sort the table and then

compare up to three columns to identify duplicate rows. The duplicate rows are then copied

to a new workbook (but not deleted from the original table).

Form Fields

· Select Source Table: Select the workbook, worksheet, and range where the data is located.

The table does not have to be an Excel table - any range will work.

· Select Columns to Compare: Select up to 3 columns to sort by and identify duplicates.

· Output To: You can output to a new worksheet or to a new workbook.

· Worksheet name: Optional field to name the output worksheet.

7.8 Remove Hidden Rows

The Remove Hidden Rows is related to the Extract Filtered Rows tool. However, instead of

taking the filtered data and extracting it to a new worksheet, the Remove Hidden Rows tool

will delete the hidden rows in a filtered table.

Form Fields

· Select Source Table: Select the workbook, worksheet, and range where the data is located.

The table does not have to be an Excel table - any range will work.

· Save Workbook: See Close and Re-Open Workbook for details.
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8 Shapes Tools

8.1 Select Shapes by Type

The Select Shapes form allows you select all the shapes on a worksheet, or filter the

selection by symbol type. (Note: The words shape and symbol are used synonymously on

this form.)

Form Fields

· Shape listing: Lists the selection checkbox, the text contained in the shape (if any), the

symbol type, the top left column and row where the shape is located.

· Select all: Checks all the select boxes in the list.

· Unselect all: Unchecks all the select boxes in the list.

· Filter by symbol type: Displays a popup allowing you to filter the selection by the symbol

type. After checking / unchecking the desired types, click anywhere else on the form to

close the popup.

8.2 Group All

In a single click, groups all the shapes on the active worksheet into a single shape. Grouping

shapes can make it easier to move a block of shapes. Also, it sometimes helps with

rendering issues Excel has when printing or saving to PDF a worksheet with a large number

of shapes.

8.3 Ungroup All

In a single click, ungroups any grouped shapes on the worksheet.

8.4 Extract Text

The Extract Text tool extracts all the text contains in shapes and outputs it to the worksheet.

Form Fields

· Shape listing: Includes a listing of the text and a selection checkbox indicating whether to

extract the text for each shape.

· Sort by: Sorts the text listing alphabetically or by shape position (column then row, or row

then column).
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· Output range: Indicates where on the worksheet the text will be extracted.

· Link shape content to cells: If checked, any changes to the text in the worksheet will

automatically update the text in the shape.



Trim Text 29

© 2018 BreezeTree Software, LLC

9 Trim Text

9.1 Advanced Trim Tool

In addition to standard leading and trailing space trimming, the Advanced Trim tool allows you

to trim based on a set of criteria.

Form Fields

· Trim leading and trim trailing: You can trim one or both with the following options:

o White space: spaces, tabs, or hidden new line characters.

o Number of characters: Specify a fixed number of characters to trim.

o Before / after characters: Specify one or more characters to trim before.

§ Inclusive / Exclusive: When trimming before or after specific characters, inclusive

will trim the specified characters and exclusive will not.

o Numbers: Trim any leading or trailing numeric characters.

o Letters: Trim any leading or trailing letter characters.

o Non-alphanumeric: Trim any leading or trailing characters that are not letters or

numbers.

· Trim all excess white space: Trims double spaces, tabs, or new line characters in the

middle of the text.

· Save workbook: See Close and Re-Open Workbook for details.

9.2 Trim Selection

There are four trim options that work directly on the selected range:

· Trim left: Trims the leading white space.

· Trim right: Trims the trailing white space.

· Trim left and right: Trims all leading and trailing white space.

· Trim left, right and double-spaces: Trims the leading and trailing white space, plus it

removes any double spaces, tabs, or new line characters in the middle of the text.
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9.3 Clean Text

Removes any non-printable characters from the text. This is useful if you have copied and

pasted text into Excel from sources with non-clean text.

9.4 Clear Empty Strings

This tool will clean up cells that have residual empty strings.

Common Use Cases:

· The Excel function COUNTA() counts the number of cells in a range that aren't empty.

Some cells can appear to be empty, but COUNTA() counts them as containing text.

· If a cell formula result that returned an empty string "" and was converted to a value, the

cells would not appear to contain anything but would still be treated as having content.

When you sort the range or double-click a cell's edge to navigate to the next empty cell, the

result would not behave as expected.
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10 Change Case

10.1 Change Case Tool

This tool allows you to change the case of the text as follows:

· Upper case: THIS IS A SAMPLE.

· Lower case: this is a sample.

· Title case: This Is A Sample.

· Sentence case: This is a sample.

The only difference between the Change Case Tool and the direct Text menu options is that

the form allows you to set the range and has the option to trim the text before applying the

changes.

10.2 Change Case on Selection

The Text menu has the following options to change the case of the text in the currently

selected range:

· Upper case: THIS IS A SAMPLE.

· Lower case: this is a sample.

· Title case: This Is A Sample.

· Sentence case: This is a sample.

Note: The workbook is automatically saved before applying the case change.

10.3 Change Name Case

The Change Name Case tool will iterate over the cells in the selected range and apply

common capitalization rules to the names.

Form Fields

· Range: Allows you to set the range to capitalize (it will initially contain the range selected

prior to opening the form).

· Only process names in all caps or all lower case: If checked, Spreadspeed will apply name

capitalization rules only to names that are all capitals or all lowercase (e.g. JOHN SMITH"

or "john smith").

· Do not capitalize compound name parts: If checked, sets compound name parts to lower
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case. See Compound Names section below for more details.

· Capitalize leading Al, Ben, and Van names: These names are common compound names

and first names. If they appear as the leading name in a cell, then they will be capitalized if

checked. If you are processing a list of cells containing first names or full names, you will

likely want this option checked.

· Save workbook: See Close and Re-Open Workbook for details.

Compound Names

Compound names have particles that indicate "of a family name" or "of a location". In most

cases, they are lower case, such as the "von" in Maria von Trapp. In other cases, the

capitalization rules for compound names are not uniform. "Van Der" and "van der", "Al-" and

"al-", and "Ben-" and "ben-" are examples of compound name parts that are frequently

capitalized or un-capitalized.

if the Do not capitalize compound name parts option is checked, all compound name parts

are forced to lowercase.

(The one exception is "de La", where the "La" is capitalized by Spreadspeed.)

Mac Exceptions

Names beginning with "Mac", such as MacDonalds, typically have the letter after Mac

capitalized. However, there are many exceptions, plus some that are spelled either way -

such as "MacIntire" or "Macintire". The Mac Exceptions list contains an initial list of Mac

names that do not have the following letter capitalized. You can edit this list, with one name

per line, to add or remove exceptions.

Suffixes

The Suffixes tab lists many common generational and professional name suffixes.  You can

edit this list, with one name per line, to add or remove suffixes. Many common suffixes, such

as "Jr." do not need to be added to the list because they are capitalized by the normal name

capitalization rules. You only need to include names that have all capitals (e.g., DDS for

dentist) or mixed casing (e.g., PhD). Variants that include a period after each initial also do

not need to be included because they are capitalized by the default capitalization rules, (e.g.
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D.D.S.).
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11 Prefix / Suffix

The Add Prefix / Suffix tool allows you to add text before or after the existing text in each cell

of the selected range.

Form Fields

· Range: Select the range for this operation.

· Prefix and Suffix Options

o Text: Plain text to add before or after each cell's content.

o Alpha series: Adds an upper or lower case alphabetic series before or after the text.

Every 26 characters, the series increments in the same way the Excel columns do (e.

g., AA, AB, AC).

o Numeric series: Adds a numeric series (1, 2, 3, ...) before or after the text, with the

option of setting a fixed width (001, 002, 003, ...).

o Spacer: Optional character(s( to place between the prefix or suffix and the text.

· Skip Options: The options allow you to skip cells with formulas, blank cells, and hidden

cells.

· Reset Series: If you are using an Alpha series or Numeric series applied to multiple

columns, this option will reset the prefix or suffix to A or 1, respectively, at the top of each

column.

· Trim existing content: Trims any leading or trailing white space from the cell text before

applying the prefixes or suffixes.

· Save workbook: See Close and Re-Open Workbook for details.
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12 Number Operations

12.1 Fill Range with Random Numbers

Fills a range of cells with a set of random numbers.

Form Fields

· Range: Select the range to fill. (This field is preset with the selected range when the form is

opened.)

· Distribution: Select a Uniform or Normal (Gaussian) distribution.

· Minimum value: The lower end of the numeric range.

· Maximum value: The upper end of the numeric range.

· Round to: The number of decimal places in the results.

Note: This uses the Box-Muller transformation for generating the Normal distribution.

12.2 Perform Math Operations in Place

The Perform Math Operations in Place tool will perform a variety of numeric functions on a

range, overwriting the original content.

Form Fields

· Range: Select the range to perform the math operations on. (This field is preset with the

selected range when the form is opened.)

· Function: Choose from one of the functions below.

o Absolute value

o Acos

o Add

o Asin

o Atan

o Ceiling

o Cos

o Cosh

o Divide
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o Exp

o Floor

o Inverse

o Log

o Log10

o Max

o Min

o Modulo

o Multiply

o Negative Value

o Pow

o Round

o Sin

o Sinh

o Sqrt

o Subtract

o Tan

o Tanh

o Toggle Sign

o Truncate

· Parameter: If required by the function, this field will prompt you with the necessary

parameter.

· Description: Description of the function.

· Save workbook: See Close and Re-Open Workbook for details.

12.3 Negate Selected Values

As the name implies, this tool will negate the sign of any numerical values in the selection (e.

g., -500 becomes 500).

12.4 Remove Non-Numeric Characters

Removes any character that is not a number (0-9) from the text in the selected range.
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12.5 Convert Text to Number

This tool will find all the cells in the selected range that have numbers stored as text and

converts them to numbers, retaining the original formatting where possible.

Accepted Formats

· Integers

· Decimals

· Percentages (%)

· Negative numbers: minus "-5.00" and accounting "(5.00)" formats.

· Currency symbols: $, £, €, and ¥.

12.6 Convert Formulas to Values

Converts all the formulas in the selected range to their calculated values.

12.7 Round Numbers in Place

Round numbers in the selected range to a user-specified number of digits.

Note: This is not the same as the Increase Decimal or Decrease Decimal toolbar functions

on the Home tab in Excel. This feature will round the number to the specified decimal places

and replace the existing value with the rounded value.

12.8 Set Numbers to Fixed Width

Set the width of numbers in the selected range to a user-specified number of digits before

and after the decimal point. If the number is smaller then the set width, it will be prefixed with

leading zeroes (e.g., 001, 002, 003, etc.).

Note: If the input range contains cells that set set as Text formatting or have a hidden

apostrophe, they will be converted to numeric values.
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13 Date Operations

13.1 Fill Range with Random Dates

Fills a range of cells with a set of random dates.

Form Fields

· Range: Select the range to fill. (This field is preset with the selected range when the form is

opened.)

· Distribution: Select a Uniform or Normal (Gaussian) distribution. 

· Start date: The lower end of the date range.

· End date: The upper end of the date range.

· Date format: A dropdown list of common date formats. See Date Formats for details.

· Date separator: choose from dash, slash, dot, or space ("-", "/", ".", or " ").

· Use localized day and month names: Uses the built-in Excel localized names based on

your system settings.

Note: This uses the Box-Muller transformation for generating the Normal distribution.

13.2 Convert Text to Date

Converts textual date strings into Excel date values. This is commonly needed when data is

imported from non-Excel sources and the dates are not recognized as such by Excel.

Form Fields

· Range: Select the range to convert. (This field is preset with the selected range when the

form is opened.)

· Output format: A dropdown list of common date formats.

· Date separator: choose from dash, slash, dot, or space ("-", "/", ".", or " ").

· Use localized day and month names: Uses the built-in Excel localized names based on

your system settings.

· Save workbook: See Close and Re-Open Workbook for details.

Related:

· If the selected range contains entries that are already recognized by excel as dates, this
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tool will not attempt to convert them and change their format. You will need to use the 

Change Date Formats tool for changing existing date entries.

· See Date Formats for a full listing of the date format codes

13.3 Change Date Formats

Changes the date format for any cell containing a date in the selected range.

Form Fields

· Range: Select the range to change the formatting. (This field is preset with the selected

range when the form is opened.)

· Output format: A dropdown list of common date formats. See Date Formats for details.

· Date separator: choose from dash, slash, dot, or space ("-", "/", ".", or " ").

· Use localized day and month names: Uses the built-in Excel localized names based on

your system settings.

· Save workbook: See Close and Re-Open Workbook for details.

13.4 Date Formats

Date Codes

Date Part Date Code Display

Day d 1-31

dd 01-31

ddd Sun-Sat

dddd Sunday-Saturday

Month m 1-12

mm 01-12

mmm Jan-Dec

mmmm January-December

mmmmm J-D (1st letter of month)

Year yy 00-99

yyyy 1900-9999

Locale [$-800] or *

(placed before date)

Use localized day and month names
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Time Codes

Time Part Time Code Display

Hour h Hours as 0-23

hh Hours as 00-23

Minute m Minutes as 0-59

mm Minutes as 00-59

Second s Seconds as 0-59

ss Seconds as 00-59

ss.00 Fractions of a second

AM/PM AM/PM 12-hour clock (e.g,, 2 PM)

A/P 12-hour clock (e.g,, 2 P)

{none} If AM/PM omitted, will display 24-hour

clock

Span [h]:mm Elapsed time in hours

[mm]:ss Elapsed time in minutes

[ss] Elapsed time in seconds
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14 Data Operations

14.1 Subtotals

The Subtotals tool is similar to the built-in Subtotals feature in Excel but it has a few

significant differences (improvements). The Spreadspeed Subtotals tool, instead of grouping

the original data, will extract the data from the existing range and place the output in any

location that you specify. Also, the Spreadspeed Subtotals tool does not need recognizable

headings and can operate on any range.

Form Fields

· My data has headers: If checked, the items listed in the "Apply function to" field will be listed

by their header names, otherwise column letters are used.

· Input Range: Select the range to perform the subtotals on. (This field is preset with the

selected range when the form is opened.)

· Output cell: The location where the output will be placed.

· For each change in: Select the column that identifies subgroups.

· Use function: Select from the following list of operations.

o Sum

o Count

o Average

o Min

o Max

o Product

o Count Numbers

o StdDev

o StdDevp

o Var

o Varp

· Apply function to: Check the columns that you want the specified function applied to.

· Sort by change column: If checked, it will sort the data by the column selected in the "For

each change in" field.

· Ignore hidden cells: If checked, any values in hidden rows within the input range will be
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excluded from the calculations.

· Output results as: Select formulas or values.

14.2 Sum and Percentages

Given a column of numbers, the Sum and Percentages tool will put the sum at the bottom of

the column and calculate the percentage that each cell value contributes to the sum. By

default the percentages are output to the column at the right of the values column.

This tool does not sort the data, so you may want to sort the data prior to using this tool rank

the percentage or cumulative percentage columns effectively.

Form Fields

· Input Column: Select the range to perform the sum and percentages on. (This field is

preset with the selected range when the form is opened.)

· Sum cell: The location where the sum of the column will be placed.

· Percentage column: The location where the percentages will be placed.

· Add column with cumulative percentages: If checked, it will add a running total of the

percentages next to the percentage column.

· Save workbook: See Close and Re-Open Workbook for details.

14.3 Descriptive Statistics

Given a range of values, the Descriptive Statistics tool will create a listing of the Mean,

Standard Error, Median, Mode, Standard Deviation, Sample Variance, Kurtosis, Skew,

Range, Minimum, Maximum, Sum, Count, and Confidence Interval.

Form Fields

· Input range: Select the range to generate the statistics for. (This field is preset with the

selected range when the form is opened.)

· Output cell: The location where the stats will be placed.

· Select statistics: A checked list showing the type of statistics available. Check those that

you want to include in the output.
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· Function type: Excel 2010 introduced .S and .P versions of some statistical functions,

which base the calculations on whether the input data represent as sample or the entire

population. (For Excel 2007 users, this option is unavailable and defaults to the legacy

versions of the VAR and STDEV formulas.)

· Confidence level: Set the confidence level.

· Distribution type: Select whether the confidence level is based on a Normal distribution or a

Student's t distribution. (For Excel 2007 users, this options is unavailable and defaults to

Normal).

· Add labels next to output: If checked, will add a label to the left of each descriptive stat. If

your output cell is in column A, then no labels can be generated.

· Save workbook: See Close and Re-Open Workbook for details.

14.4 Remove Repeating Data

The Remove Repeated Data can be used on a range that has the same content repeated in

rows or columns. Given a range like this:

Removing the repeating data will result in this:
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Form Fields

· Range: Select the range to remove the repeating data from. (This field is preset with the

selected range when the form is opened.)

· Direction: Set the direction based on whether the repeated data is in columns or rows.

· Save workbook: See Close and Re-Open Workbook for details.

Related

· See Fill Repeated Data.

14.5 Fill Repeating Data

The Fill Repeating Data can be used on a range that has gaps in the content. Given a range

like this:

Filling in the missing data will result in this:
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Form Fields

· Range: Select the range to fill-in the repeating data. (This field is preset with the selected

range when the form is opened.)

· Direction: Set the direction based on whether the repeated data is in columns or rows.

· Save workbook: See Close and Re-Open Workbook for details.

Related

· See Remove Repeated Data.

14.6 Perform Random Sort

The Random Sort takes a range and sorts the rows randomly.

Form Fields

· Range: Select the range to randomly sort. (This field is preset with the selected range when

the form is opened.)

· First row contains headers: Determines wether the first row has headers and should be

excluded from the random sorting.

· Save workbook: See Close and Re-Open Workbook for details.

14.7 Create Validation Dropdown List

Validation lists are used to limit the content of a range to a preset list. The Create Validation

Dropdown List tool will build a validation list from existing content, store it in a column, and

apply the validation rules to your input range.

Form Fields
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· Select unique items from range: Lets you create the list of items in the validation list

dropdown from the content in the range specified.

· Enter dropdown items: Manually create a list for the validation list dropdown.

· Store validation list: Indicates where on the worksheet the validation list source will be

stored.

· Hide validation list column: If checked, the column is hidden after creation.

· Apply validation rules to range: Select the range that the validation list

· Input Message: If "Show input message" is checked, a screentip will display when the user

selects a cell in the validation range. The "Input title" and "Input message" fields determine

what appears on the screentip.

· Error Message: If "Show error message" is checked, an message box will appear if the

user attempts to enter a value that is not in the validation list. The "Error title" and "Error

message" fields determine what appears in the message box.
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15 Export Operations

15.1 Save Chart to Image File

The Save Chart to Image File tool will save a chart as a png, bmp, gif, jpg, or tif image.

Currently, the tool works only for charts embedded in worksheets, not standalone charts on

their own sheets.

Form Fields

· Select chart: If there are more than one chart on the active worksheet, the dropdown will list

all the charts by name.

· Image Preview: Shows a thumbnail of the chart.

· Image type: Select the image format.

· File name: Defaults to the name of the chart but can be changed before saving.

· Folder: The directory where the file will be saved.

15.2 Save Range to Image File

The Save Range to Image File tool will save a snapshot of a worksheet range as a png, bmp,

gif, jpg, or tif image.

Form Fields

· Range: Select the range for the image snapshot. (This field is preset with the selected

range when the form is opened.)

· Image Preview: Shows a thumbnail of the image.

· Image type: Select the image format.

· File name: Defaults to the name of the worksheet but can be changed before saving.

· Folder: The directory where the file will be saved.

15.3 Save Shapes to Image File

The Save Shapes to Image File tool will save a snapshot of the shapes on a worksheet as a

png, bmp, gif, jpg, or tif image. This is useful for saving images of diagrams created with

AutoShapes or SmartArt.
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Form Fields

· Image Source

o Shapes only: For worksheets with mixed content (shapes and cell content), this option

limits the export to just the shapes.

o Shapes and cell content: Select the range for the image snapshot, making sure to fully

encompass the range containing the shapes that you want in the image.

· Image Preview: Shows a thumbnail of the image.

· Image type: Select the image format.

· File name: Defaults to the name of the worksheet but can be changed before saving.

· Folder: The directory where the file will be saved.

15.4 Save Range to Text File

Saves the selected range to a text file. When prompted with the Save dialog, you can

selected a .csv (comma separated values) or .txt (tab separated values) text file format.

15.5 Create HTML Unordered List

Creates an unordered list (<ul><li>content</li></ul>) from the current selection. If the

selected range contains more than one column, only the first column is captured in the list.

The results are displayed in a form that you can copy and paste to your HTML file.

15.6 Create HTML Ordered List

Creates an ordered list (<ol><li>content</li></ol>) from the current selection. If the selected

range contains more than one column, only the first column is captured in the list. The results

are displayed in a form that you can copy and paste to your HTML file.

15.7 Create HTML Table

Creates a table (<table><tbody><tr><td>content</td></tr></tbody></table>) from the current

selection. Unlike the ordered and unordered list tools, this tool will accept a range with

multiple columns. Before creating the table, you will be prompted whether the first row

contains headings. If so, the first row is enclosing in a <thead> section with <th> elements.

The results are displayed in a form that you can copy and paste to your HTML file.
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16 Format Operations

16.1 Reset All Cell Styles

The Reset All Cell Styles feature will delete all custom styles in the current workbook and

revert any built-in styles to their original formatting if they have been modified.

16.2 Delete Unused Custom Cell Styles

The Delete Unused Custom Cell Styles feature will delete all custom styles that are not being

used in the current workbook.

16.3 Selectively Clear Formats

The Selectively Clear Formats tool is a quick way to clear the format options in a range

without clearing all the formatting.

Form Fields

· Range: Select the range to fill. (This field is preset with the selected range when the form is

opened.)

· Borders: If checked, all borders will be removed.

· Fill color: If checked, cell fill colors will be reverted to "No fill".

· Font styles: If checked, the font is reset to the Excel default font and font size. Other styles,

such as bold, underline, strike-through, and italic, will also be reset.

· Number and date formats: If checked, resets the number format to "General". Warning: Any

dates will be displayed as a number.

· Text alignment: If checked, text alignment is reverted to its default (left aligned for text and

right aligned for numbers).

· Save workbook: See Close and Re-Open Workbook for details.

16.4 Clear Excess Formatting

This tool does two things:

1. First, it runs the Reset Used Range tool.

2. Then, it clears all the formatting in cells that extend beyond the used range.
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For example, if you have selected Row 1 and set the font to bold for headings, you could

easily have thousands of unused cells with the font set to bold. This tool will clear the

formatting from those unused cells, reducing the size of the Excel file.

16.5 Merged to Center Across

Un-merges selected cells and converts them to a horizontal alignment of Center Across

Selection.
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17 Dependency Navigator (Auditor)

The Dependency Navigator displays all the formula precedents and dependents in the active

worksheet. The navigator opens in a task pane (side panel). It organizes the formulas by their

call trace, and has separate tree views for the precedents and dependents. Where possible,

the navigator will list the name of any Named Ranges used in formulas.

Fields

· Dependents and Precedents tabs: The Dependency Navigator has separate tabs for the

dependents and precedents views, with the operations for each handled separately. 

· Click Here to Load Dependents / Load Precedents: Click these buttons to load the formula

dependent and precedent traces. 

· Dependents Tree: Clicking on an item in the Dependents tree view will select the range and

show the dependent arrows for the formula. Dependent ranges are displayed in a tree to

show the trace hierarchy. 

· Precedents Tree: Operates in the same fashion as the Dependents tree view.

· Expand All / Collapse All: Expand or collapse all the nodes in the active dependent or

precedent list.

· Find range: Selecting an item from the list will jump to it's first location in the listing

· Trace arrow depth: If "All levels" is selected, the entire trace arrow route is shown. If "One

level" is selected, the precedent or dependent arrows are show only for the selected range.

· Hide Trace Arrows: Clears all the trace arrows on the displayed worksheet.

Load Time and Dependency Navigator Refresh

· The average benchmarked times to load Dependents or Precedents is 30 seconds for

every 1000 formulas. For example, a sheet with 10,000 formulas would load in 30 seconds,

and a sheet with 100,000 formulas would load in 300 seconds (5 minutes). These are just

benchmarks on our in-house systems, and your own load times may vary considerably

based on the formula complexity and your system's hardware.

· Due to the load times, the Dependency Navigator will not automatically refresh when you

switch sheets or workbooks, or edit the formulas on the active sheet. You must click the

Load Dependents / Load Precedents button(s) again.
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Color Codes

· Items that reference another sheet are colored blue.

· Items that reference another workbook are colored red.

Spreadspeed uses the built-in Excel Precedents and Dependents references, which have

some limitations. In some cases, a cell with a formula that references an external range will

return the precedent range and sometimes it will not. In the cases where is does not,

Spreadspeed will list the formula itself in the Precedents listing.

Redundant Listings

Because a cell can have more than one dependent, it can be listed multiple times in the

Precedents view. Likewise, because a cell can have more than one precedent, it can be

listed multiple times in the Dependents view.

Item Selection

Selecting an item in either the precedents or dependents listings will select that range on the

worksheet and show the trace arrows. Selecting an item listing an external formula (instead

of a range address) will cause the parent cell containing the formula to be selected instead of

the precedent range used in the formula.
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18 Visual Audit (Auditor)

The Visual Audit tool will review the worksheet and color code the cells using built-in Excel

styles based on the type of content in them. The color coding is a useful auditing tool to

review the content landscape of your worksheet. For example, a color code indicating a plain

number next to other cells containing formulas might indicate a error in the worksheet.

Content Types

· Input: Cells that are Unlocked and have dependents (are used in the formulas of other

cells).

· Locked Input: Cells with formula dependencies that are locked.

· Formulas: Normal formulas.

· Unlocked Formulas: Cells with formulas that have the protection set to unlocked.

· Linked Formulas: Formulas that reference other worksheets or workbooks.

· Cells with errors: Cells, typically with formulas, that have been flagged by Excel as having

an error.

· Numbers

· Dates

· Text

Options

· Add comment to cells with any cell error: Adds a comment to the cell with a description of

the error. If checked, the Visual Audit tool checks for all cell errors, even the ones that you

don't have enabled through Excel Options > Formulas > Error checking rules.

· Restore original worksheet: restores the worksheet to its original formatting and removes

the cell  error comments. If this option is left unchecked, you can use the Restore Format

tool revert the cell formats back to their previous state and use the Delete All Comments

tool to remove the cell error comments.

· Save workbook: See Close and Re-Open Workbook for details.
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19 Audit Reports (Auditor)

19.1 Worksheet Comparison Report

The Worksheet Comparison Report runs the same comparisons as the Compare

Worksheets tool. However, instead of color coding the changes, splitting the screen, and

letting you navigate through the cells with differences, this report will simply output the results

to a new worksheet.

19.2 Master Audit Report

The Master Audit Report is a unified interface to run you run the individual reports listed

below. The reports will be output to the same worksheet.

· Cell Errors Report

· Circular References Report

· Comments Report

· External References report

· Hyperlinks Report

Broken Links

Through this dialog, you also have the option to specify whether the Hyperlinks Report

outputs a list of all the hyperlinks in the workbook, or just the broken hyperlinks.

· Only broken links: Check for links to external files and flags as broken if the file doesn't

exist.

· Check for broken URL's: Requests the Head of the URL (not the entire content) with a

timeout set at 2 seconds. If your workbook has a lot of hyperlinks to web pages, it may take

a very long time to generate the report.

19.3 Cell Errors Report

The Cell Errors report scans all the cells in each sheet of the workbook and lists any cells

that have the following Excel error codes:

· xlEvaluateToError: Evaluates to an error value (#DIV!, #NULL, #N/A).

· xlEmptyCellReferences: Formula refers to empty cells.
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· xlOmittedCells: Formula omits a cell for a region.

· xlInconsistentFormula: Contains an inconsistent formula for a region.

· xlInconsistentListFormula: Contains an inconsistent formula for a list.

· xlUnlockedFormulaCells: Formula cell is unlocked.

· xlTextDate: Contains a text date with 2 digit years.

· xlNumberAsText: Cell contains a number stored as text.

· xlListDataValidation: Cell contains a list validation error.

Notes

· Cells with the error codes xlOmittedCells and xlEmptyCellReferences typically also return

the xlEvaluateToError code.

· Locating cells with the inconsistent formula error codes (xlInconsistentFormula and

xlInconsistentListFormula) will find some inconsistent formulas, but it is is not a robust

method for locating them all. Formulas replaced with values will not show up as errors, nor

will altered formulas in the last cell in a row or column. Using the Find Inconsistent

Formulas tool on a specified range is a better method, and the Visual Audit tool is also

useful for locating values in a range of formulas.

Related

This is one of the reports that can be run individually or through the Master Audit Report.

19.4 Circular References Report

The Circular References report will find all formulas that include their own range in the

formula parameters. The built-in Excel tool Formulas > Error Checking > Circular References

will often show only the one circular reference on a sheet, even if there are two or more. The

Spreadspeed Circular References will list them all.

Related

This is one of the reports that can be run individually or through the Master Audit Report.
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19.5 Comments Report

Creates a new worksheet that lists all the comments contained in the workbook. The

comments report includes the sheet name, the cell address, the cell value, the cell formula (if

applicable), and the comment text.

Related

This is one of the reports that can be run individually or through the Master Audit Report.

19.6 External References Report

The External References Report will list all the cells containing external formulas, including

formulas that reference ranges on other worksheets within the same workbook as well as

references to other workbooks.

Related

This is one of the reports that can be run individually or through the Master Audit Report.

19.7 Hyperlinks Report

The Hyperlinks Report lists all the hyperlinks contained in the workbook. 

Related

This is one of the reports that can be run individually or through the Master Audit Report. If you

run the report through the Master Audit Report, you have the option to limit the output to list

only hyperlinks that are broken plus specify whether to check broken URL's.

19.8 Formulas Report

The formulas report will create a listing of all the unique formulas in the

workbook. The report includes the sheet name, the cell address,

whether the formula is an array formula, and the formula itself in

FormulaR1C1 format. The individual Formulas Report lists only the

unique R1C1 formulas in a worksheet, so the cell address is the first

address encountered containing the formula.
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For more advanced control of the formula output, see the Master Audit Report.

19.9 Named Ranges Report

The Named Ranges report will list all the named ranges in the current workbook, including it's

parent 9sheet or workbook), the range that it refers to, whether it has errors, and whether it is

hidden.
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20 Inconsistent Formulas (Auditor)

20.1 Find Inconsistent Formulas

The Formulas menu offers two options - Find Inconsistent Formulas in Columns and Find

Inconsistent Formulas in Rows. They both work on the selected range, and with the Columns

option comparing formulas vertically and the Rows option comparing them horizontally.

Key Points

· When an inconsistent formula is identified, the cell is marked with the built-in Excel "Bad"

cell style.

· If applied to a row or column within an Excel Table, be aware that several of the red table

styles may make the "Bad" cell style less obvious.

· After making corrections, you can use Restore Formats to revert the formatting to its

original state.

20.2 Flag Inconsistent Formulas

The Flag Inconsistent Formulas tool operates on the entire worksheet. It compares each cell

with the surrounding cells and tries to determine whether there is an inconsistency. 

There is a deliberate difference in wording between the Find Inconsistent Formulas tools and

the Flag Inconsistent Formulas. With the Find tools, you explicitly set a range (columns or

rows) that you expect the formulas to be the same in. With the Flag tool, Spreadspeed

analyzes the entire sheet and makes an educated guess as to which cells are inconsistent. If

the inconsistency is clear cut, it will mark the cell using the "Bad" style. If the inconsistency is

not definitive, it flags any region with anomalies using the "Check Cell" style.
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21 Compare Worksheets (Auditor)

The Compare Worksheets tool is an auditing tool that highlights the differences between one

worksheet and another. The differences are highlighted in the second sheet selected, which

is treated as the audit sheet. The difference highlighting is prioritized by formulas, values,

number and date formats, and then cell formats.

Compare Worksheets Form Fields

· Worksheet 1: Select the workbook and worksheet names that the other sheet will be

compared to.

· Worksheet 2: Select the workbook and worksheet that will be audited. This is the sheet that

will be color coded to highlight the differences.

· Comparison options: Check the boxes for the types of information to compare. 

· Color code: Optional, change the color code for each type of cell difference.

· Save workbook: See Close and Re-Open Workbook for details.

When you click OK, the differences between the sheets are analyzed, the audit sheet is color

coded, the two workbooks are displayed side by side, and the Compare Navigator dialog

opens on the right-hand side of Excel.

Compare Navigator Form Fields

· Change List: Lists the cell differences, including the cell address and the type of change

formula, value, number / date format, or cell format.

· Baseline and Audit cell values / formulas: These two read-only fields show the baseline and

audit cell formula for the item selected in the Change List. No values are displayed for

number or cell format differences.

· Copy: You can choose to copy all the cells or just the selected cells from sheet 1 to sheet 2

or sheet 2 to sheet 1. Note however, that since sheet 2 has had the auditing formatting

applied to cell differences, copying from sheet 2 to sheet 1 will copy the formulas, values,

and number formats, but styles are not copied. 

· Restore formats and view upon closing: Restores the full worksheet view from side by side,

and automatically applies Restore Format. If you uncheck this option, you can manually

reset the view by clicking the Excel View tab and un-toggling the "View Side by Side" and
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"Synchronous Scrolling" options, and then clicking the Restore Format button on the

Spreadspeed ribbon tab.

Comparing Worksheets in the Same Workbook

The Compare Worksheets tool uses the Excel view side by side option, which only works

with separate workbooks. If you want to compare two sheets in the same workbook, you can

make a copy of one worksheet to use as the baseline sheet by following these steps:

· Right-click on the baseline worksheet tab.

· Select "Move or Copy ..." from the context menu.

· On the Move or Copy dialog, under "To book:" select "(new book)", and then check the

"Create a copy" option.

· When you click OK, a copy of the sheet is created in a new workbook, which you can use

for the Compare Worksheets baseline.
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22 Hyperlinks Audit (Auditor)

22.1 Open Hyperlinks Navigator

The Hyperlinks Navigator is a task pane (side panel) that lets you see all the hyperlinks in the

workbook. The navigator lists the hyperlinks grouped by worksheet. Any links to non-existent

files are highlighted in red. Clicking on an item in the navigator will jump to the range

containing the link, and show the source, link target, display text, and screen tip, if applicable.

If you switch workbooks, add, or remove any hyperlinks, the Reload Hyperlinks button will

refresh the listing.

22.2 Remove Hyperlinks

There are two Remove Hyperlinks menu items for the worksheet and the selected range.

Each tool will remove the hyperlinks and convert them into plain text. Note that the converted

text is the display text, not the hyperlink address.

22.3 Convert Hyperlink Formulas

The Convert HYPERLINK() Formulas to Standard Hyperlinks will convert all hyperlink

formulas in the current worksheet to the standard type that are typically created by using the

insert hyperlink feature.
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23 Comments Audit (Auditor)

23.1 Delete All Comments

There are two options under this menu - delete the workbook comments or delete the current

worksheet comments. In both cases, you will be prompted to confirm the delete operation.

The workbook is saved before the comments are deleted, so the comments can be restored

by using the Close and Re-Open Workbook tool.

Note

When deleting all the comments in the workbook, only the comments in visible worksheets

are deleted.

23.2 Remove User Name

This tool will iterate through all the comments in the worksheet and remove the user name(s).

Form Fields

· Apply to: Opt to remove user names from the entire workbook or just the active worksheet.

· User name list: Check any names to remove.

· Save workbook: See Close and Re-Open Workbook for details.

Note: Because Excel files can be edited by more than one user, this tool checks for any

possible user name. The only way to detect these is to find any text before the first colon (:) in

the comment.
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24 Restore Formats

Some of the auditing tools will apply formatting to worksheet cells to highlight issues or

identify content type. Clicking the Restore Format button will revert the cell styles back to their

previous format.
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25 Support

25.1 Spreadspeed Support

Contact information

Support: support@breezetree.com

Sales: sales@breezetree.com

Reporting a Problem

If you need to contact support to report a problem, the following information is helpful.

· Which Spreadspeed feature you were trying to use when the error occurred.

· If possible, the steps needed to re-produce the problem.

· If possible, a copy of the Excel file you were working on. (All material is treated as

confidential.) 

· Your Excel version.

· Your Windows version.

· The version of Spreadspeed that you are running. From the Spreadspeed ribbon tab, click

Help > About to see the version number.

· The contents of the Spreadspeed event log. The SpreadspeedEvents.log file is located in

your Documents folder.
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25.2 Log Files

Spreadspeed logs errors and other events. If contacting support to report a problem, it is

often helpful to view the following log file:

· \Documents\Spreadspeed.log

· \Documents\Add-in Express\adxloader.log

· \Documents\Add-in Express\adxregistrator.log

25.3 Troubleshooting

Installation Error

If you receive an error message during installation, the following items cover nearly all the

cases reported to our support:

1. The majority of installation problems are solved by running the Admin-Level Setup, which is

available on the BreezeTree Downloads page. As the name implies, it does require

administrative privileges on your system. Depending on your organization's policies, you

may need to have your IT department install it for you.
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2. FlowBreeze runs on Windows only. (Sorry - we are not able to provide a Mac compatible

version.)

3. If you have previously installed FlowBreeze, you must uninstall the older version before

installing the updated one.

Spreadspeed Ribbon Tab 

If the Spreadspeed ribbon tab does not appear when you open Excel, please follow these

steps to troubleshoot the problem.

1. Make sure you install Spreadspeed under your login

Spreadspeed does not require admin privileges to install and is installed per-user. If you,

or someone from your IT department, logged in under an admin account to install

Spreadspeed, it will only be available to the login account - not yours. If this has happened

to you, uninstall Spreadspeed and re-install it under your login. 

2. Check the Disabled Items list

Excel 2010 - 2016

· Click the File tab on the Excel ribbon.

· Click the 'Excel Options' button in the left menu.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'Disabled Items' from the list, then click the 'Go…'

button.

· If Spreadspeed is listed, select it and click the 'Enable' button, then restart Excel.

Excel 2007

· Click the Office Button in the upper left corner of Excel.

· Click the 'Excel Options' button on the bottom-right corner of the window.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'Disabled Items' from the list, then click the 'Go…'

button.

· If Spreadspeed is listed, select it and click the 'Enable' button, then restart Excel.

3. Check the COM Add-ins list
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Excel 2010 - 2016:

· Click the File tab on the Excel ribbon.

· Click the 'Excel Options' button in the left menu.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'COM Add-ins' from the list, then click the 'Go…'

button.

· If Spreadspeed3 is listed, make sure the checkbox next to it is checked.

Excel 2007:

· Click the Office Button in the upper left corner of Excel.

· Click the 'Excel Options' button on the bottom-right corner of the window.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'COM Add-ins' from the list, then click the 'Go…'

button.

· If Spreadspeed3 is listed, make sure the checkbox next to it is checked.

4. Check the security settings

Excel 2010 - 2016:

· Click the File tab on the Excel ribbon.

· Click the 'Excel Options' button in the left menu.

· Click "Trust Center" on the left navigation panel.

· Click the "Trust Center Settings" button.

· The "Message Bar" panel should be open by default. Make sure that the "Show in

Message Bar..." option is selected.

· Next, click "Add-Ins" from the left menu and set the options per the Add-ins Options

section below.

Excel 2007:

· Click the Office Button in the upper left corner of Excel 2007.

· On the bottom-right of the popup menu, click the "Excel Options" button.

· Click "Trust Center" on the left navigation panel.
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· Click the "Trust Center Settings" button.

· The "Message Bar" panel should be open by default. Make sure that the "Show in

Message Bar..." option is selected.

· Next, click "Add-Ins" from the left menu and set the following options;

Add-ins Options

· Option 1:

o Check the box labeled "Require Application Add-ins to be signed by Trusted

Publisher"

o Uncheck "Disable notification for unsigned add-ins"

o Uncheck "Disable all Application Add-ins"

· Option 2: (not recommended)

o  Leave all the settings on this panel Unchecked.

Excel needs to be restarted for these security changes to take effect. If you selected

Option 1, then the next time you restart Excel, follow the steps in Security Warning -

Enable Spreadspeed (below).

5. Security Warning - Enable Spreadspeed (Excel 2007 and 2010)

If "Require Application Add-ins to be signed by Trusted Publisher" is checked in the Excel

Trust Center (see the section above)., you will see a warning when you open Excel after

installing Spreadspeed. The actions differ slightly between Excel 2007 and 2010.

Excel 2010 - 2016:

If you see the security message shown below, click the "Application add-ins have been

disabled" label. (Clicking "Enable Content" will enable only for the current session).
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:

Excel will show the info screen below. Click the "Enable Content" dropdown and select

"Advanced Options".

On the security options dialog, select "Enable all code published by this publisher" and

click OK.
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Excel 2007:

If you see the security message shown below, click the "Options" button.

On the security options dialog select "Enable all code published by this publisher" and

click OK.
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6. Installation - restart required

If Excel was running during the installation, it will need to be re-started again for the

Spreadspeed toolbar to display.

7. Download website

Did you download the program from www.breezetree.com? The BreezeTree website is

the only official site for downloading Spreadspeed. To get the latest version, download

Spreadspeed only from www.breezetree.com. Download sites (including popular ones

such as download.com and tucows) often host old versions of Spreadspeed. 

Downloading from any other site is not recommended!

If the above checks didn't reveal the problem, please contact BreezeTree support.
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25.4 Uninstalling Spreadspeed

To uninstall Spreadspeed, please follow these steps:

1. Open the Windows Control Panel.

2. Open the program listing:

· In Windows 8, click "Uninstall a program".

· In Windows 7 and Vista, click "Programs and Features".

· In Windows XP, click "Add or Remove Programs".

3. Select Spreadspeed in the listings and click Uninstall from the top menu bar.
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26 How to Buy

Purchasing Options

Single-user, Site and Enterprise licenses of Spreadspeed are available for purchase ...

· Through the BreezeTree website (www.breezetree.com). We accept payments using most

major credit cards, wire transfer, and PayPal.

· Via Purchase Order (see Purchase Orders and Quotes, below).

Purchase Orders and Quotes

Please contact sales@breezetree.com if you would like to place a purchase order or need a

formal quote. The standard invoice terms are Net 30. The method of delivery is electronic

(download).

W-9 Statements

A W-9 is available upon request. Please contact support@breezetree.com to obtain a copy.
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